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Introduction

Serveur web

I Un explorateur internet permet à l’utilisateur de demander une
ressource.

I Cette ressource est servie par un serveur web.
I L’URL est l’adresse de cette ressource.
I Une ressource peut être une page HTML, une image, etc.

Absence de ressource
Si la ressource n’est pas là, une erreur 404 est générée par le serveur.
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Introduction

Protocole HTTP
Le client et le serveur communique via le protocole HTTP.

I Requête GET : Récupérer de l’information sans changer l’état visible
du serveur.

I Requête POST : Demande de modification des informations côté
serveur.

I ...

Codes de statut

I 1xx Information
I 2xx Succès : 200 pour OK, 201 pour "Created" (une ressource a bien

été créée), etc.
I 3xx Redirection
I 4xx Erreur client : 400 si mauvaise requête, 404 si ressource

inexistante, etc.
I 5xx Erreur serveur : 500 si erreur interne au serveur, etc.
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Introduction

GET vs POST

I Les données transportées par un GET sont limitées.
I Une requête POST a un corps pour les données.
I Les informations d’un GET sont transportées par l’URL sous la forme

example.fr/blah?arg=12&arg2=bonjour.
I Attention à l’aspect sécurité d’une requête GET.
I Néanmoins si besoin de transporter un mot de passe, il faut utiliser un

chiffrement (https) car le corps du POST est en clair.

Sémantique des requêtes

I GET = Récupérer de l’information.
I POST = Mettre à jour une information.
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Introduction

Requêtes idempotentes

I Idempotent en math : f (x) = f (f (x))
I Dans le web, ça signifie que deux mêmes requêtes d’affilées donne le

même résultat qu’une seule requête.

Scénario

I L’utilisateur paie son panier.
I Il y a un petit lag et il décide de recharger la page : la requête est

donc ré-envoyée.
I Si la requête n’est pas idempotente, alors son compte sera débité

deux fois.
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Introduction

Requêtes idempotentes II

Dans la norme HTTP, on considère que :
I GET est idempotent.
I POST n’est pas idempotent.

C’est notamment pour ça que les navigateurs demandent si on est sûr de
vouloir ré-envoyer la requête (car ce n’est pas idempotent).

Requête POST
C’est au développeur de rendre les requêtes POST idempotentes.
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Introduction

Pages statiques et dynamiques

Limites d’un serveur web

I Peut seulement servir des pages statiques.
I Ne peut pas sauvegarder de données dans une base de données ou

fichiers.

I CGI (Common Gateway Interface) spécifie comment le serveur web et
un programme externe communiquent.

I Est coûteuse car on lance le programme à chaque requête...
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Introduction

Servlets

En Java, au lieu de créer des processus systèmes, assez lourd, ce sont des
threads qui sont utilisés.

I Un seul programme Java est lancé dans la JVM, le servlet container.
I Quand une requête arrive, le serveur exécute la requête dans un

nouveau thread.
I Le container dirige la requête vers un servlet qui se charge de traiter

l’information utilisateur et de renvoyer une page HTML.
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Servlets
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Servlets Configuration

Serveur de servlets

I On utilisera Tomcat, archive zip à télécharger
https://tomcat.apache.org/download-80.cgi

I Voir les deux slides suivantes pour la configuration sous Eclipse ou
Netbeans.
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Servlets Configuration

Configuration sous Eclipse

Ajouter le serveur Tomcat

1. Window > Preferences > Server > Runtime Environnement > Add
2. Sélectionner "Apache Tomcat v8.0" et ajouter le chemin du serveur

téléchargé précédemment.

Projet Web avec Maven

1. File > New > Other > Maven > Maven Project > Next > Next
2. Sélectionner l’archétype group id : org.apache.maven.archetypes et

artifact id : maven-archetype-webapp.
3. Finir la création du projet Maven en ajoutant le group id (par exemple

upmc) et l’artifact qui est le nom du projet.
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Servlets Configuration

Configuration sous Netbeans

Ajouter le serveur Tomcat

1. Dans les onglets à gauche, sélectionner Services.
2. Servers > Add Server > Apache Tomcat
3. Dans Select location, préciser le chemin du serveur téléchargé

précédemment.

Projet Web avec Maven

1. File > New Project > Maven > Web Application
2. Finir la création du projet Maven en ajoutant le group id (par exemple

upmc) et l’artifact qui est le nom du projet.
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Servlets Premier Servlet

Télégraphe

I Nous allons développez une application web de chat en ligne nommée
Télégraphe en utilisant les servlets.

I On développe cette application incrémentalement afin d’aborder les
différents principes des servlets :
1. V1 : Une page de login où l’utilisateur rentre un pseudo, l’application

répond avec une page contenant ce pseudo.
2. V2 : Utilisation des JSPs pour décrire la page avec le login utilisateur.
3. V3 : Création d’une nouvelle servlet pour envoyer des messages.
4. V4 : Garder le pseudo dans une session.
5. V5 : Utilisation d’un objet pour stocker les messages d’un salon de

discussion.
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Servlets Premier Servlet

Dissection d’un Servlet

public class WebChat extends HttpServlet
{

protected void doGet (
HttpServletRequest request ,
HttpServletResponse response )

throws ServletException , IOException
{

response . setContentType ("text/html; charset =UTF -8");
try ( PrintWriter out = response . getWriter ()) {

out. println (" <! DOCTYPE html >");
out. println ("<html >");
out. println ("<head ><title > Servlet Chat </ title ></head >");
out. println ("<body >");
out. println ("<h1 > Hello ! Servlet Chat at " +

request . getContextPath () + " </h1 >");
out. println (" </body ></html >");

}
}

}
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Servlets Premier Servlet

Récupérer les paramètres d’une requête

La requête HTML :
<form action =" sendMessage .do">

<textarea rows="4" cols="50" name="msg">
Enter your message here ...

</textarea >
<input type=" submit ">

</form >

Traitement côté serveur :
protected void doPost ( HttpServletRequest request ,

HttpServletResponse response )
{

String msg = ( String ) request . getParameter ("msg");
}

Note : getParameterValues() permet de récupérer les paramètres à
plusieurs valeurs (pensez aux checkbox).
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Servlets Premier Servlet

Points clés

I On a deux méthodes doGet et doPost selon que l’utilisateur envoie
une requête GET ou POST.

I On écrit la page HTML de retour dans l’objet
response.getWriter(), comme quand on print dans la console avec
System.out.println.

I request contient les arguments de la requête utilisateur, par exemple
si on a un formulaire avec un champ id="toto" on récupère sa
valeur avec :

request . getParameter ("toto")

Si l’objet retourné est null alors l’utilisateur n’a pas rempli ce champ.

Pierre Talbot (IRCAM) Développement Web 17 / 46



Servlets Premier Servlet

Un premier Servlet

Une page de login où l’utilisateur rentre un pseudo, l’application répond
avec une page contenant ce pseudo

I Télécharger sur le site du cours l’archive TelegrapheV1Template.zip et
exécutez le code.

I Prendre en compte le cas où l’utilisateur a entré un pseudo vide, dans
ce cas ré-afficher la page de login.

I En cas de succès, afficher “Super login JFdu67” si l’utilisateur a entré
“JFdu67” comme login.

Consulter l’adresse http://localhost:8080/Telegraphe, Telegraphe
étant le nom de la ressource.
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Servlets Premier Servlet

Cycle de vie d’un Servlet

1. Une requête HTTP arrive sur le container.
2. Grâce à l’URL, le container constate que c’est pour un Servlet (ou

non).
3. Le container crée les objets HttpServletResponse et

HttpServletRequest qui encapsule la requête et la réponse HTTP.
4. Le container appelle la méthode service() sur le Servlet dans un

nouveau thread.
5. Quand la méthode service() se termine, le container envoie la

réponse et nettoie les deux objets créés à l’étape 3.
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Servlets Premier Servlet

Gestion des requêtes dans le Servlet

I La méthode service() est une méthode de HttpServlet et appelle
doGet ou doPost en fonction de la requête HTTP.

I Ces méthodes sont surchargées dans le Servlet de l’utilisateur.

protected void service (
HttpServletRequest req ,
HttpServletResponse resp)

throws ServletException , IOException
{

String method = req. getMethod ();
if ( method . equals ( METHOD_GET )) {

doGet (req , resp );
} else if ( method . equals ( METHOD_POST )) {

doPost (req , resp );
} else if (. . .)
. . .
} else {

resp. sendError ( HttpServletResponse . SC_NOT_IMPLEMENTED , errMsg );
}

}
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Servlets Premier Servlet

Une seule instance du Servlet

Un servlet n’est instancié qu’une fois par le container, la même instance
est ré-utilisée pour toutes les requêtes.

Règles d’utilisation

I Pas de variable d’instance dans un Servlet (sauf si on veut que les
requêtes partagent les mêmes données, néanmoins attention à la
persistance).

I Ne pas mettre les méthodes doPost ou doGet en synchronized
(sinon on perd l’avantage du parallélisme) ; la section critique doit
être aussi petite que possible.
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Java Server Pages (JSP)
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Java Server Pages (JSP)

Java Server Pages (JSP)

I Utiliser des out.println(" <html>") n’est pas très élégant et
adapté...

I Au lieu de mettre du HTML dans du Java, pourquoi ne pas mettre du
Java dans du HTML?

I Ce qui a donné naissance aux JSP.

JSP

I Une JSP est contenue dans un fichier .jsp
I Elle est compilée par le serveur vers un Servlet utilisant les

out.println(...).
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Java Server Pages (JSP)

Exemple de JSP

<! DOCTYPE html PUBLIC " -// W3C // DTD XHTML 1.0 Strict // EN"
"http :// www.w3.org/TR/ xhtml1 /DTD/xhtml1 - strict .dtd">

<html xmlns ="http :// www.w3.org /1999/ xhtml " xml:lang="fr" lang="fr">
<body >
<% if( request . getParameter ("msg") == null ||

request . getParameter ("msg"). isEmpty ()) { %>
Vous devez envoyer un message .

<% } else { %>
Le message est <%= request . getParameter ("msg") %>

<% } %>
</body >
</html >

C’est le code Java qu’on doit échapper maintenant. Ce qui est entre <% et
%> s’appelle un scriptlet.
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Java Server Pages (JSP)

Variables implicitement accessibles

Dans les scriptlets, on a accès à un certain de variables pré-déclarées :
I JspWriter out : Permet d’appeler println dans un scriptlet.
I HttpServletRequest request : La requête HTTP.
I HttpServletResponse response : La réponse HTTP.
I HttpSession session : La session courante.
I . . .
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Java Server Pages (JSP)

Balises JSP

I Scriptlet <% int count = 0; %> : N’importe quel code Java peut
être entre ces balises.

I Expression <%= count++ %> : Équivalent à
out.println(count++);, noter l’absence de ;.

I Directive de page <%@ page import java.util.*; %> : Ici un
import nécessaire si on utilise ArrayList dans un scriptlet par
exemple.

I Directive de page <%@ page contentType="text/html" %>
I . . .
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Java Server Pages (JSP)

Traduction du JSP vers un Servlet

import j a v a x . s e r v l e t . ∗ ;
import j a v a x . s e r v l e t . h t tp . ∗ ;
import j a v a x . s e r v l e t . j s p . ∗ ;

public class Pr intMsg_jsp extends HttpJspBase {
// Tout ce qui est entre <%! %> vient i c i .

public void _ j s pS e r v i c e ( H t t pSe r v l e tReque s t r eque s t ,
H t t pSe r v l e tRe spon s e r e s pon s e )

throws Se r v l e t E x c e p t i o n , IOExcept i on
{

J spWr i t e r out = . . . ;
H t tpSe s s i on s e s s i o n = . . . ;

out . p r i n t l n ( "<!DOCTYPE html PUBLIC \"−//W3C//DTD XHTML 1 .0 S t r i c t //EN\" " ) ;
. . .
if ( r e q u e s t . ge tParamete r ( "msg" ) == null | |

r e q u e s t . ge tParamete r ( "msg" ) . i sEmpty ( ) ) {
out . p r i n t l n ( "Vous devez envoye r un message . " ) ;

} else {
out . p r i n t l n ( " Le message e s t " + r e qu e s t . ge tParamete r ( "msg" ) ) ;

}
. . .
out . p r i n t l n ( "</html>" ) ;

}
}
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Java Server Pages (JSP)

Télégraphe V2

Utilisation des JSPs pour décrire la page avec le login utilisateur.
I Création d’une JSP “room.jsp” (ça deviendra notre salon de

discussion plus tard) dans le répertoire Web pages.
I Afficher le pseudo de l’utilisateur en utilisant les scriplets.
I Dans Login.java, vous pouvez utiliser

request.getRequestDispatcher("room.jsp") comme pour
afficher une page HTML.
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Mapping URL vers Servlets
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Mapping URL vers Servlets

Dispatch des requêtes utilisateurs

I Lorsque le container reçoit une requête utilisateur, il faut bien qu’il
sache vers quel servlet la distribuer.

I On lui donne l’information dans le fichier WEB-INF/web.xml.

web.xml

<servlet >
<servlet -name >Log </ servlet -name >
<servlet -class >upmc. telegraphe .Login </ servlet -class >

</servlet >
<servlet -mapping >

<servlet -name >Log </ servlet -name >
<url -pattern >/ login .do </url -pattern >

</servlet -mapping >

servlet-name est un nom interne du service, servlet-class est le
chemin complet vers la classe et url-pattern est l’URL tel que décrite
par exemple dans <form action="login.do">.
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Mapping URL vers Servlets

Télégraphe V3

Création d’une nouvelle servlet pour envoyer des messages.
I Dans la JSP room.jsp, ajouter un formulaire qui récupère un

message de l’utilisateur et envoie une requête POST vers
sendMessage.do.

I Créer une nouvelle servlet Room.java qui ne fait que rediriger vers la
JSP room.jsp.

I Créer le mapping dans web.xml.
I Mettre à jour la JSP room.jsp pour afficher le dernier message

envoyé.
I PS : on ne se tracasse pas du pseudo pour le moment.
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Session
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Session

Session

I Problème : Après avoir envoyer un message, le serveur a “oublié” le
pseudo de l’utilisateur : il n’y pas retransmis dans les futures requêtes.

I Le protocole HTTP est stateless, après une requête/réponse, le
serveur a oublié le client.

Session

I Le serveur peut créer un cookie qui contient un identifiant unique.
I Ce cookie est envoyé dans la première réponse.
I Le client doit ré-envoyer ce cookie à chaque fois.
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Session

Créer et récupérer une session

protected void doPost ( HttpServletRequest request ,
HttpServletResponse response )

{
HttpSession session = request . getSession ();

}

I La méthode getSession() crée la session si elle n’existait pas déjà
et la retourne.

I L’ajout du cookie dans la réponse et le traitement de la requête est
géré par le container.

I getSession(false) retourne null si il n’y a pas de session courante
(et n’en crée pas).
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Session

Utiliser une session

I String pseudo = (String) s.getAttribute("pseudo")
I s.setAttribute("pseudo", pseudo)
I ...

Attention : Ne pas confondre getParameter et getAttribute où le
premier contient les données de la requête courante et l’autre les données
de session.
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Session

Télégraphe V4

Garder le pseudo dans une session.
I Lors de la première connexion, on enregistre le pseudo dans la session

avec session.setAttribute(...).
I Utilisez cette information dans room.jsp pour récupérer et afficher le

pseudo.
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Contexte de servlet
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Contexte de servlet

Contexte d’exécution

On veut attaquer la dernière version de notre chat. Comment faire pour
garder en mémoire les messages précédents ?

I Les paramètres de request ne sont valides que pour la requête
courante.

I Les attributs de session ne sont valides que pour un seul utilisateur.
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Contexte de servlet

Information globale

I Il n’existe qu’une seule instance de servlet et donc toutes les requêtes
partagent le même servlet.

I Dès lors, peut-on stocker les messages dans une variable d’instances
du servlet ?

I Oui, cela marchera mais il y a un endroit dédié aux informations de
servlet appelé ServletContext.

I L’avantage est que, sous certaines conditions, lorsque vous redéployer
votre application, le contexte n’est pas perdu tandis que les variables
d’instances le sont.
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Contexte de servlet

ServletContext

I On peut stocker des attributs dans le ServletContext d’une
application web.

I Par exemple
getServletContext (). setAttribute (" roomCounter ", new Integer (0));

stock un objet dans l’attribut "roomCounter" qui peut-être récupéré
avec getAttribute.

ATTENTION

I Plusieurs requêtes simultanées signifient que l’objet ServletContext
peut être accédé de manière concurrente vu qu’il y a un thread par
requête.

I Il faut protéger la modification des attributs avec des méthodes
synchronized.
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Contexte de servlet

Télégraphe V5

Utilisation d’un objet pour stocker les messages d’un salon de discussion.
I Créer un objet upmc.telegraphe.model.MessageRoom.java qui

contiendra une liste de message avec une fonction push
(synchronized !).

I Dans la méthode public void init() throws
ServletException du Servlet Room, enregistrer une nouvelle
instance de l’objet MessageRoom.

I Afficher les messages dans la JSP ; vous pouvez communiquer l’objet
MessageRoom à la JSP en passant par les attributs de request.

Pierre Talbot (IRCAM) Développement Web 41 / 46



Et ensuite...
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Et ensuite...

AJAX

AJAX

I Pour éviter que l’utilisateur ait à recharger la page pour récupérer les
données, on peut utiliser ajax.

I Les requêtes et réponses ne seront plus en HTML mais en JSON par
exemple.

I Attention à bien changer le MIME.

Pour faire un chat en ligne, une technique est d’interroger le serveur toutes
les secondes si il y a des nouveaux messages.
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Et ensuite...

Web Socket

Web socket

I Avec les sessions et même AJAX, le serveur ne peut pas prévenir le
client qu’une information vient d’arriver.

I Une technique est de laisser ouvert une requête HTTP et ainsi garder
la connexion entre le client et le serveur, c’était une sorte de hack
appelé Comet.

I Maintenant le protocole Web socket est plus adapté. C’est un mode
du protocole HTTP.

Ceci sont des techniques générales, pouvant fonctionner avec tous
langages et frameworks.
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Et ensuite...

À ne pas manquer

Compléter vos connaissances Java

I Le mécanisme de réflection et les annotations.
I Des frameworks web complet comme Spring ou Struts.
I ...
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Et ensuite...

À ne pas manquer

Connaissances générales

I Apprendre un langage fonctionnel (par exemple OCaml et puis
Haskell).

I Lire le livre de Peter Van Roy
(https://www.info.ucl.ac.be/~pvr/book), disponible en français
aussi.

I Se renseigner sur les langages synchrones (Lustre, Esterel, ...).
I Langages pour le web expérimentaux : Hop et HipHop.
I Consulter notamment http://www.college-de-france.fr/site/

gerard-berry/_course.htm
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